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Microscope Type : Widefield / Confocal / Nipkov Disc 
 

Objective Lens Numerical  
Aperture : 

10 X: 0.3 
20 X: 0.5 
40 X: 1.3 [Oil] 
63 X: 1.4 [Oil] 
63 X: 1.2 [Water] 

 
Lens Medium Refractive Index : 
The Numerical Aperture of an objective is the 
refractive index of the immersion medium times 
the sine of the half-aperture angle. Because 
the sine <= 1.0, the NA is always lower than the 
medium refractive index. If a 1.4 NA oil 
immersion lens is used to image into a watery 
object total internal reflection will truncate the 
NA. As a rule of thumb the effective NA is .1 
lower than the manufacturer's specification. 

1.518 [Zeiss Oil N518] 
1.33 [Water] 
1.0008 [Air] 
 

 
Medium Refractive Index : 
This is the refractive index of the medium in 
which the specimen is embedded. For a 
frequently used medium such as glycerol (75%) 
this is 1.44. For low values of Rm such as 1.32 for 
water, the computed PSF for an oil immersion 
lens is only valid near the coverslip-medium 
interface due to spherical aberration effects in 
deeper layers. In such cases we recommend 
lenses optimized for the refractive index of the 
medium. 

1.32 [Water] 
1.44 [Glycerol 75%] 
1.0008 [Air] 
1 [Air] 
 

 
Excitation & Emission 
Wavelength[nm]: 

See experimental conditions 
 

 
Pinhole radius [nm]: Huygens works with 
the backprojected pinhole radius (rb): 
rphys : physicel pinhole diameter (LSM image 
information) 
mobj : objective magnification factor (10, 20, 40 
or 63X) 
msys : fixed internal magnification (2 for Pascal 
in CECS) 
NA : numerical aperture 

rb = rphys / (mobj * msys) 
 
rb = 0.61 * λ * NAiryDisc / NA 

 
XYZ-Sample Size [µm]: See experimental conditions 

 



Signal to Noise Ratio (SNR): 
The SNR can be estimated with the 
following rules of thumb: Good quality 
Wide Field images recorded with a 
cooled CCD camera microscope can 
easily have S/N ratios above 30. 
Moderate WF images have an SNR of 
around 20. Good quality confocal 
fluorescence images have a S/N ratio 
between 20 to 40.  
 
In noisy confocal images the SNR can 
be computed from the  pixel value of a 
single photon event in the background:  
SNR = (maximumVoxelValue / single Hit-
Intensity)0.5. 
______________________________________ 
Alternative Method for SNR-
estimation: 

El cuociente entre Señal y Ruido (SNR) 
es un parámetro variable, que requiere 
el sistema de deconvolución, para 
poder estimar para cada píxel dentro 
de la imagen si su contenido 
corresponde a un evento aleatorio 
(ruido que obedece a una estadística 
de Poisson) o una señal real.  
 
SNR se obtiene de la siguiente manera: 

 
1. Obtener una imagen 

representativa (ver Fig. A). 

2. Generar un histograma de 
frecuencias f en una zona de la 
imagen que no contiene señal 
(f(FR) es una función que depende 
del fondo (F) y del ruido (R), ver Fig. 
A/B). 

3. La intensidad del fondo I(F) 
(background) de la imagen se 
define por el valor mínimo del 
Histograma f(FR): I(F) = min(f(FR)) = 0 
en el ejemplo Fig. B).     

4. La intensidad del ruido I(R) 
obedece a una estadística de 
Poisson. En una distribución de 
Poisson, el valor del promedio 
µ(I(R)) es igual a su varianza  σ² 
(I(R)). 

5. El promedio de la intensidad de 
una señal µ(I(S)) se aproxima con 
una estadística de Gauss (µ(I(S) = 
102, ver Fig. C). 

6. Con estos parámetros, la SNR se 
calcula de la siguiente manera:  
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See pages 13/20 in User Guide and below. 
 
 
 
 
 
 
 
 
 
 
_____________________________________________ 
 
 

 



Huygens Professional
User Guide

Scientific Volume Imaging
S I



Copyright © 1997-2003 by Scientific Volume Imaging b.v.,
Alexanderlaan 14 1213 XS Hilversum
P.O. box 615,
1200 AP Hilversum,
The Netherlands

S I

Huygens Professional
User Guide

Scientific Volume Imaging b.v.
Alexanderlaan 14
1213 XS Hilversum

P.O. box 615
1200 AP Hilversum
The Netherlands



All rights reserved

Cover illustration:

Macrophage recorded by Dr. James Evans, Whitehead Institute, MIT, Boston MA,
USA, using wide field microscopy.

At the right the same dataset: Macrophage fluorescently stained for tubulin (yellow/
green), actin (red) and the nucleus (DAPI, blue). Left part: original data; right part:
as deconvolved with the classical Maximum Liklihood Etimation method (MLE).

The image was visualized using FluVR. FluVR is the Simulated Fluorescence Pro-
cess (SFP) volume rendering package from Scientific Volume Imaging.
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CHAPTER 1 Introduction

This guide is useful to the beginner in deconvolution and to the expert that starts
using the Huygens Professional toolkit.
For the expert we recommend also to study the Huygens Reference Manual.

contents In chapter 1 we explain the installation
In chapter 2 you deconvolve your first image
In chapter 3 we help you determining some important parameters and give you hints for basic
image data-acquisition

What is Huygens Professional?
Huygens professional is an image processing software package tailored for deconvolution of
microscopic images. It enables you to deconvolve a wide variety of images ranging from 2D
widefield (WF) images to 4D multi-channel two-photon confocal images or from Scanning
disk confocal microscopes. Also people who use experimental set-ups like 4p-microscopes
may benefit from the software. The Huygens Professional toolbox contains the following fea-
tures:

Image deconvolution
functions

• Accelerated Maximum Likelihood Estimation restoration algorithm optimized for low light level
images

• Iterative Constrained Tikhonov-Miller restoration algorithm
• Quick Tikhonov-Miller and Quick MLE restoration algorithms
• Point Spread Function (PSF) measurement tool box to derive a microscopic PSF from finite sized

micro bead images, containing:
• Automatic alignment and averaging procedure to combine the signal from different micro beads in one

or more images
• PSF reconstruction tool to correct for the finite size of micro beads
• Generates a theoretical Point Spread Function for widefield, confocal and two-photon microscopes

based on electromagnetic diffraction theory
• Automatic bleaching correction of 3D and 4D widefield images and 4D confocal and multi-photon

images
• Z-drift corrector tool for timeseries that enables you to correct for movement in the Z (axial) direction

that could have been occurred for instance by thermal drift of the microscope table.

Basic image processing
capabilities

• Capability to handle multiple images
• Time series support
• Multi parameter (multi channel) image elements (stacked or packed)
• Basic data types: unsigned byte, 16 bit signed integer, 32 bit float, 2 x 32 bit complex
• Per image undo/redo capabilities
• Scripting and batch processing environment based on Tcl (Tool Command Language)
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Core image processing
functions

• Create, destroy, copy, copy block, convert, split, join, zoom, rotate, iso-sample, shift, replicate image
• Add/remove border, shift to sub-pixel accuracy, mirror image, swap image octants
• Arithmetic operations on two image operands, one image operand and a scalar, mathematical functions

on one image operand, soft clipping & thresholding
• 4D Gaussian filter of arbitrary widths, 4D Laplacian filter
• Generate solid and hollow bandlimited spheres, generate Poisson and Gaussian noise
• Real and complex 4D Fast Fourier transforms

Reporting & display
operations

• Image statistics
• Report sampling density with respect to Nyquist rate
• Image histograms of images with up to three channels
• Plots of Energy Flux as function of time and axial position

Image file I/O • Reads ICS, Imaris® classic, numbered series TIFF, Zeiss Lsm, Metamorph STK, Biorad pic, Olympus
’Fluoview’, Leica files and Delta Vision IMSubs (r3d), IPLab Tiff.

• Writes ICS, Imaris® classic, Biorad pic, TIFF (Leica style and classic numbered series TIFF).
• 4D read support: ICS, numbered ‘stk’, numbered Leica-TIFF, numbered TIFF
• Export to FluVR, the volume renderer based on spectral fluorescence
• Export to Imaris®

Analysis functions • Threshold and label 3D image
• Analyze labelled objects: compute centre of mass, volume and integrated intensity
• Estimate background
• Measure distance
• Compute image ratio
• Compute colocalization coefficients
• Compute the co-occurrence matrix of an image

Visualization • Thumbnail images
• Multiple Expand viewers on one or more images. Each Expand viewer is able to

• Show x-y, x-z or y-z slices for selectable points in time while optimizing contrast on a global or per-
plane basis

• Show Sum or MIP projection, animate projections of time series
• Display single channel images in False or True color; multi channel images in True color
• Report individual pixel/voxel positions and values

• Swing through planes or time
• Slicing positions in expand viewers can be dynamically linked for easy image comparison

Installation and system requirements

Installing the Huygens Professional.

Installing the software Linux

The Huygens professional Linux distribution is a so called ‘rpm’ file.

Example: Your rpm file is called:huygens-2.3.7-17.i386.rpm

To install this file you open a shell, go to the directory were this file is located, become supe-
ruser and type:

rpm -Uvh huygens-2.3.7-17.i386.rpm

note: capital ‘U’ and space between ‘rpm’ and ‘-’.
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After installing the software type hugens2 in a shell to start the software. A directory
/usr/local/svi will be created; the executables will be installed in /usr/local/bin

Irix

Currently the Irix distribution is a single ‘tardist’ file containing various components. By
default all components are installed. Become superuser and type:

swmgr -f dist65-2.3.5-2.tardist

Press ‘Start’ in the Softw are Manager window.

A directory /usr/local/svi will be created; the executables will be installed in /usr/local/bin and
/usr/sbin.

Obtaining a license
key

To run the software beyond the free ware functionality you will need a license key. This tempo-
rary license key can be obtained by sending SVI a reply on the email that was sent to you when
you downloaded the software.

Please answer the questions in the email and paste your computers system ID at the correct
place. Your computers system ID can be read in the Menu item Help>Product information.

Once we have received the system ID together with the information from your reply and the
original email, we will generate a personalized license for your system. This license will only
work on that specific computer.

Installing the license
key

The installation created a filehuygensLicense in the directory /usr/local/svi. Become root and
add the license string on a separate line in the file.

System requirements

Memory requirements Recommended RAM memory: 512 MB or larger.

Irix All SGI equipment running Irix 6.5 running Irix 6.5 on a MIPS R5000 processor or higher. On
Octane or higher systems automatically a 64bit multiprocessing executable is installed. This
allows the software to access more than 4GB of RAM and to distribute the computational work
over many processors.
• All SVI packages on Irix require the SCSL mathematical library. This is distributed along with Irix; an

up to date version can be downloaded from the SGI web site.

Linux Linux: RedHat and SuSE distributions. Since Linux versions evolve rapidly best consult SVI’s
www.svi.nl web page to see which Linux distributions are currently supported.

A standard ethernet card is required to provide your computer with a system ID.
• Processor: Pentium III or IV (Intel) or Athlon (AMD).
• Graphics card: any fairly modern card will do.
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Addresses and URLs

Where can we be
reached?

Scientific Volume Imaging b.v.

Alexanderlaan 14
1213XS Hilversum
The Netherlands

You can call us directly by phone:

++31 35 6859405 or ++653 345445,
or fax us at: ++31 35 6837971,
or email us at: info@svi.nl

http://www.svi.nl

Distributors

A list of distributors can be found on our web site:

http://www.svi.nl/distributors

Support and FAQ Please visit the following web site for support issues and to consult the FAQ:

http://support.svi.nl

On this web site you’ ll also find a form to submit questions to SVI’s support team.

Where can I find more
about Silicon Graph-
ics?

Please visit the SGI web site:

http://www.sgi.com

There you can find addresses of sales and support offices which exist in many countries.

IBM Life Sciences http://www-1.ibm.com/industries/lifesciences/
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CHAPTER 2 Getting Started

This chapter will help you to get through the basic procedures in deconvolving an
image.

Deconvolving my first image

Searching the SVI
Knowledge Base

It’ s good to know that an extensive support base is available where you may find answers to
questions that come to front while reading this document. FAQ’s are available for many items
such as deconvolution and general microscopy, installation, memory management, visualiza-
tion, file formats, platforms and reported bugs.:
http://support.svi.nl/

Step 1: Start Huygens
Pro

Starting Huygens Pro

- IRIX: You may start the Huygens program by clicking the ‘Icon Catalog’ on your Irix desk-
top.
- LINUX: Via the KDE application menu.
- LINUX / IRIX: By opening a shell and typing ‘huygens2’. It is a good idea first to go to the
directory where your images are stored, using the command ‘cd’.

The huygens2 command starts the program that comes up with the Main Window with 4
black thumbnail images (see Figure 2).

Figure 1. Starting Huygens Pro. If you type an ampersand (&) after the
command the prompt (>) will return.
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Thumbnail images The Main Window is initially loaded with 4 black thumbnail images, images that are already
prepared for you, but where all image data are zero’s. One of the images is called ‘psf’ which
will be used in the deconvolution steps as you will learn soon.

Step 2: Load an image Loading your image

First you have to load an image. Select ‘Open’ from the File menu in the Main Window and
find the file to be processed.

In the distribution you will findthe demo image faba32 (the filepair faba32.ids and faba32.ics,
where faba32.ids is the file containing the raw data and faba32.ics is a header file, containing
all microscope parameters). Click on one of these, no matter which one.

You may combine steps 1 and 2: starting Huygens and loading images using a single command
line:
huygens2 faba32.ics dama.ids&

This command appends the images faba32 and dama to the Main window.

If you have Tiff slices to be processed please read “Tiff file series naming convention” on
page 27 for the naming convention in order to be able to read a multi-dimensional image as a
whole.

Step 3: Inspect your
image.

Inspect your image.

• Use the slicer

Expand viewer Open the Expand viewer by pressing the Arrow-up button  from the thumbnail of

faba32. The Expand viewer is intended as a general purpose image inspection tool. It is
composed of a menu bar and a tabbed deck consisting of a Projection page, a Slicer Page

Figure 2. The Main Window with empty thumbnail images loaded by default.



Deconvolving my first image

The Huygens Professional User Guide 9

and a Parameters page. You can open as many Expand viewers as you like, on the same
image or on different images.

With the Viewer’s Slicer you can scan through the slices (in different directions). Since this
example image is not a time series, the time (t) select box is greyed.

Microscopic parameters • Verify the microscopic parameters (needed for the generation
of a PSF) like Numerical Aperture, Microscope type, sample
size, etc. by selecting the Parameters Tab from the Expand
viewer (see Figure 3).
Did you use the correct Sampling size? To find out, select
faba32 in the Main window, by clicking on the image (the
name is displayed in blue, when selected!). Now select
‘Nyquist rate’ from the Edit menu and you will be informed.
We see that the image is fairly good sampled in the x and y directions since the nyquist rate
is near to the value of one. However, the z (the x-y slices) is undersampled (the sampling
was too course). Advised is to sample in the z-direction with a distance of 166 nm or less.
Conclusion: if the Nyquist tool leaves you with values smaller then one you have under-
sampled your image. Tough luck for you now, but hopefully future recordings may benefit
from this information.
(Super sampling of an image is not a problem, although your dataset becomes unnecessar-
ily large without providing extra information).
For now we continue with the z-undersampled demo image.

Figure 3. Two Expand Viewers opened from the same image. Left the
Slicer Tab is selected, right the Projection Tab.

image is not a time
series.
‘t’-slicing is not
available.
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Histogram • The image histogram
Select the image in the Main Window and select
Image histogram from the Edit menu. An image his-
togram is created as a thumbnail image named
faba32:histo. You may use the Expand viewer for a
better view. The histogram enables you to inspect
the quality of the image visually. The one in
Figure 4 is of reasonable quality: No sharp peaks at
the extreme sites of the histogram image indicating
clipping. An example of a clipped image is shown
below.
Not also that the black space at the left hand of the
histogram. It signifiesan electronic mismatch in the
recording of the image. See “Blacklevel” on
page 20.

A clipped image example, see Figure 5.
If you see a narrow peak at the left hand side of the
histogram this signifies ‘clipping’. It occurs when
negative input signals are mapped to zero’s by the
CCD camera. See also “Clipping” on page 22.
If a peak is visible at the extreme right hand side of
the histogram it indicates saturation. Saturation is a
type of clipping caused by raising the laser intensity
above the maximum pixel value available on your
microscope. Usually, all values above the maximum
value are replaced by the maximum value. On rare
occasions they are replaced by zeroes. Clipping will
have a negative effect on the results of deconvolu-
tion, especially with WF images

Operations window In the former steps all operations were performed without any operation parameters (functions
applicable on a particular image). For example if one wants to know the image statistics no
extra information is needed but the name of the image. All these types of operations are acces-
sible from the main Window. Most operations, however, need extra input data. For example
adding some constant value to an image. This can be done in the Operations Window

Since in the next steps all image processing operations need one or more parameters you have
to work with the Operations window. You open an Operations window on an image by clicking
on the small button labelled O in the images’ Thumbnail component.

Figure 4. The image histogram
from the example

Figure 5. The image histogram
from a clipped image. A spike is
seen at the left hand site.
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Subsequently you select an operation from the Menu bar or from the Quick access buttons. The

left side of the operation window is similar to the Expand viewer. At the right side you will find
the parameter entry area. By editing the parameters you control the way the function operates.
To execute the operation, press the RUN button.

bleaching correction

Figure 6. The Operation window with the PSF button
pressed.

Menu bar
Quick access buttons

Intermezzo: check for bleaching correction

Remember, we were inspecting our image.
This extra check is given here for the sake of com-
pleteness for those using this schematic approach
for widefieldimages or confocal time series. Select
‘Plot Flux’ from the ‘Analysis’ menu in the Oper-
ation window. A typical example is shown in
Figure 7. The Demo image is a regular confocal
image: bleaching correction test makes no sense
here!
• Extra check to see if bleaching correction is

needed in widefield images or confocal time
Series. While recording widefield images or
confocal time series strong bleaching may
occur.

Figure 7. A typical example of a
bleached widefield image. Use the
‘Plot Flux’ tool from the Analysis
menu available in the Operation
window.
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Step 4: Generate a
Point Spread Function
(PSF)

The PSF is the way in which a point of your original
object is visualized in the image you’ve loaded in step 1.
Often this point is no longer a point but blurred and
spread out. The aim of the PSF is to calculate the mea-
sure of blurring in the x,y,z axis. In the final step of
deconvolution this PSF is used to come to a (in contra-
diction to the so-called ‘blind deconvolution) measured
deconvolution. A PSF can be obtained either by record-
ing small beads with known bead diameter (180 nm
beads work fine) and reconstructing a PSF from the
bead image or by calculating a theoretical PSF from the
information about your microscope settings, see
“Microscopic parameters” on page9. Huygens Pro has
many tools to handle the first method but these are
beyond the scope of this demo. For this firstimage demo
we generate a theoretical one.
A theoretical PSF can be generated by clicking the but-
ton PSF from the Operation Window. This tool com-
putes a Point Spread function from the microscopic
parameters. You need not change by now the parame-
ters. By default the psf-image will be displayed in the destination ‘psf’, which is still empty,
but any available image can be selected. Press the Run button located in the right down corner.
In thumbnail ‘psf’ you may select the Expand vie wer to see the Point Spread Function in
detail. (Figure 8)

Step 5: Estimate the
average background in
the image.

In this stage the average background in a volume image is estimated. The average background
is thought to correspond with the noise-free equivalent of the measured (noisy) image. It is
determined by searching the image first for a region with low values. Subsequently the back-
ground is determined by searching this region for the planar region with radius r which has the
lowest value. It is important for the search strategy that the microscopic parameters of the
image are correct, in especially the sampling distance and the microscope type.

The average background estimation is invoked by Estimate background from the Analysis
menu in the Operation window. The following choices are possible here:
• LOWEST VALUE (Default): The image is searched for a 3D region with the lowest average

value. The axial size of the region is around 0.3 micron; the lateral size is controlled by the
radius parameter which is set to 0.5 micron by default.

• IN/NEAR OBJECT: The neighborhood around the voxel with the highest value is searched
for a planar region with the lowest average value. The size of the region is controlled by the
radius parameter.

• WIDEFIELD: First the image is searched for a 3D region with the lowest values to ensure
that the region with the least amount of blur contributions is found. Subsequently the back-
ground is determined by searching this region for the planar region with radius r that has
the lowest value.

We are looking for the background outside the object, in a confocal image, therefore we choose
for the default ‘Lowest value’ setting. Ag ain press the Run button. The result is displayed in
the Main window’s Task reports. It is one of the values that should be known in the next step.

Figure 8. The PSF in x-z view,
using ‘compress’ contrast
mode. ‘Compressed contrast’
highlights the low intensity
values showing the typical
diabolo shape in lateral view.
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Step 6: Estimate the
Signal to Noise ratio
(SN ratio)

The Signal to Noise ratio (SN) is a num-
ber not always easy to estimate. The easi-
est way to obtain some figureis to look at
the textures of bright areas in your object
image. In the figure at left you see exam-
ples of such textures obtained from origi-
nally the same object image to which
various levels of poisson noise were
added.

Step 7: Perform a
deconvolution run,
applying the MLE
(Maximum Likeli-
hood Estimation)
method.

Applying the deconvolution process

You can choose between various deconvolution methods. Only in some special cases you
should use the ICTM (Iterative Constraint Tikhonov-Miller) method as explained in the refer-
ence manual. While selecting the MLE-button you‘ll see the following parameter values
which can be adapted:

• Number of iterations: this depends on the initial quality of your image.(e.g. 20 to 40)
• Signal to noise ratio: You have to make an estimation of the Signal to noise (SN) value from

your recorded image. Inspect your image and decide if your image is noisy (S/N < 10), has
moderate noise (10-20) or is a low-noise image (S/N> 20). See examples of noisy images in
Figure 9

• Background: This value was calculated in step 5. Copy the value from the Tasks reports
(Main window) into the field.

• Threshold quality: This number gives the maximum difference between the subsequent
iterations. If one chooses a high number (e.g. 0.1) the deconvolution may stop before the
indicated number of iterations has been completed as the threshold value has been reached
beforehand. The smaller the threshold and the larger the number of iterations the higher the
quality of deconvolution.

• Other parameters like bleaching correction and padding mode are best kept in their default
modes.

Figure 9. Images with different generated
noise levels

SN = 15 SN = 5SN = 30

Figure 10. The Operations window with the MLE button pressed.
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• Press the Run button! You will end up with
a restored image ‘c’ in the Main windo w.

After inspecting the result in the Expand
viewer you may want to perform another
deconvolution run. Maybe you also wish to
change one or more parameters. After pressing
the Run button again you will be asked, in the
case the output image destination is not
changed, if you like to do a completely new
run (the destination image is zero-ed before)
or one on top of the first run.

Step 8: Saving your
image

If you are done and wish to save the result go to the Main window and select the restored image
(c) by clicking its thumbnail (the name is in blue when selected!). From the File menu you
select the Save as ICS (International Cytometry Standard fileformat) or the Save as ... for some
other file formats.

The easy way
In the former part you learned some basic procedures for the deconvolution process and famil-
iarized you with some User interface components. This approach is in two minds about educa-
tion and demoing functionality. Deconvolution can be done easier.

Quick and easy deconvolution

Following the steps from the former example you have learned that a PSF is essential to decon-
volution. You restored your data using a PSF-image located in ’psf ’, which is either an existing
measured PSF obtained from bead images or a theoretical PSF generated from the parameters
of the parent image. You have generated a theoretical PSF and you may have noticed that you
need not inspect nor manipulate this image. And also that the background estimation tool gen-
erated a number that need to be copied by hand in the MLE deconvolution process. Since there
is no basic user interaction these steps can be automated. This is done in the MLE-time or the
QMLE tools available (Buttons) from the Operation window.

MLE-time The MLE-time tool is the most versatile deconvolution tool accessible from the Huygens Pro.
It can be used for any type of data, no matter whether this is a 2D widefieldimage or a confocal
time series. If a theoretical PSF is good enough to get by, you can skip generating one yourself
as it is done on the fly.
• There is just one thing to wait for, no extra button presses.
• Especially while using large images that are processed brick-wise the PSF is prevented

from being unnecessary large, it adapts its size to the brick size.
• In case of a multi channel image the PSF is generated for one channel at the time instead

for all at once

Figure 11. The Main Window with a
deconvolved image ’c’.
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• The PSF image is thrown away as early as possible, at least before the iterations begin.

Downside is that an automatically generated PSF is never re-used.

Note: The MLE-time is basically the same deconvolution tool as used in the Huygens Essen-
tial. Therefore there is no difference between the theoretical PSF’s as generated by Huygens
Pro and the Huygens Essential.

We recommend to use the MLE-time tool for all your deconvolu-
tion work. Only in special occasions you have recourse to other
tools as is explained in ’Which deconvolution method should you
use?’ from the Huygens Recipes.

From step 4 we repeat the deconvolution process using the ‘MLE-time’.

Proceed as follows: either Exit Huygens Pro by ‘Exit’ from the File menu in the Main window
and start a Huygens Pro from scratch and open faba32 again, or continue the session after hav-
ing cleaned images ‘psf’ and ‘c’. (click on the thumbnail image, and select ‘Zero image’ from
the edit menu, or use the shortcut ‘ALT+Z’).

Open an Operation Window from the original image (faba32). Now press Button MLE-time
and you see the display as shown in Figure 12.

Use all default values except the ‘Signal/Noise per channel’. We will use the value ‘10’ here
instead of the default value ‘20’. In the input field you see 4 numbers as prepared for a 4 chan-
nel images. We are dealing with a single channel image here therefore only the first number
should be changed to ‘10’. If you do so and press ‘Run’, your restored image will be made as
‘c’.

MLE-time Buttons
and input fields

Since the MLE-time is the key deconvolution tool we will explain the MLE-time related
parameters one by one.
• PSF (if available)

Here you may select from the list of all opened images that particular image that is used as
the PSF image. This can be either a measured PSF or an earlier generated PSF (using the
‘PSF’ b utton from the Operations window). If you don’ t use a measured PSF we recom-
mend to select the empty image ‘psf’. In this case a PSF is ‘not available’ and the software
generates PSF’s on the fly.

Figure 12. The Operations window with the MLE-time button pressed.
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• Destination of the Output image
Select an image into which the result will be stored.

• Signal/Noise per channel
Here you may give the S/N for the separate channels.

• Max. iterations
Absolute stopping criterion. See also ‘Quality change threshold’ belo w.
Deconvolution as it is done in the Huygens compute engine hinges around the idea of find-
ing the best possible estimate of the object that is imaged by the microscope. To assess the
quality of an estimate, the deconvolution algorithm computes the image of each estimate as
it would appear in the microscope and compares it with the measured image. From the dif-
ference a quality factor is computed. The difference is also used to compute a correction
factor to modify the estimate in such a way that the corrected estimate will yield a better
quality factor. This is an iterative process that should have a stopping criterion. If the proc-
ess has not yet been stopped by the ‘Quality change threshold’ it will be explicitly stopped
by the number of Maximum iterations.

• Search for background
Several choices can be made: AUTO, MANUAL, LOWEST VALUE, IN/NEAR OBJECT OR WIDEFIELD MODE.
In manual mode the background value should be specified in the Estimated background
input widget.

• Backgr. per ch. (absolute or %)
This parameter should be set to the estimated mean background in the measured image.
When restoring time series the background is likely to vary from frame to frame. The time-
enabled deconvolution tools can therefore make a survey of the background in all frames
and channels. The way this survey is carried out is determined by the ‘Search for back-
ground’ option.
Since the backgrounds established by the survey are conservative values (unless In/near
object is selected) they can be increased by a percentage. For instance 10% means all back-
ground estimates are increased by 10%. Negative percentages are also valid.
If the ‘search for background’ is in Manual-mode the number is an absolute v alue and will
be applied ‘as is’ to all frames. This v alue will be subtracted from all images in all frames.

• Bleaching correction
The bleaching correction can be ‘If possible’ or ‘Off’. In the If possible mode the software
corrects for bleaching automatically. The correction is possible for 3D and 4D widefield
images or 4D confocal images. For 3D confocal images automatic bleaching correction is
not possible.

• Threshold for quality factor increase (%)
This is the primary stopping criterion. After each iteration a quality factor is computed
from the new estimate. This factor is based on the so-called I-divergence or cross-entropy
measure of the original image and the imaged estimate. You can set a stop criterion in the
form of a threshold on the quality increase. When the quality drops below the threshold for
a few iterations in succession, iterations are stopped.
When the quality is decreasing, iterations are stopped immediately. This occurs with poor
quality PSFs.
When set to 0 the stop criterion is inactive and even in the case of decreasing quality, itera-
tions will continue.

• Iteration mode
This allows the selection of a Fast mode or a High Quality mode. In Fast mode the itera-
tions are more effective at the cost of a marginal increase of computing time per iteration
and the addition of one extra (hidden) temporarily image.

• Padding mode
Padding means that a border will be added around an image which is not only needed for
trivial things like creating extra space to be able to rotate an image without having its cor-
ners cutted off, but also to prevent ‘wrap around’ ef fects caused by the use of discrete Fou-
rier Transforms (DFT) which interprets the image as periodic, i.e. the image is continued on
all sides by exact copies of itself. Also one or more dimensions of the image hamper effi-
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cient computations of its DFT. Efficient DFT computation can be done on images with
dimensions composed of powers of 2 or small primes like 2,3,5 and 7.
AUTOMATIC: The padding depends on the image size and microscope type.
OFF (PARENT): Takes the size of the parent, so in fact no padding is made. If the sizes can
be factored into small primes, like powers of 2, and the object in the image is surrounded by
empty space off can very well be used.
PADDED PARENT: In this mode extra volume is added to the image. The border size com-
puted by the software is a trade-off between FFT compute efficiency and the size of the
original image. The size of the border therefore depends on the size of the original image.
As an example: consider a image with 31 layers. The next size, 32, would allow efficient
Fourier transforms because it is a power of two. However, to avoid wrap around effects a
single extra layer is not enough. In this case the software will select a total of 40 slices as
compromise between compute efficiency, image size and wrap around effects.
FULLY PADDED PARENT: This mode is especially relevant for widefield images; for other
microscope types it is equivalent to Padded Parent.

Padding and widefield
images

In restoring widefield images the software must remove the contributions (blur!) of all XY
slices of the object to each slice of the object. This means that to compute the top slice of
the object everything below must be taken into account, using the bottom half of the PSF.
For the bottom part of the object the top part of the PSF is needed. Thus the full PSF must
be twice as high as the object. Worst case the object is just contained in the image, so in that
case the PSF must be twice as high as the image. Since the use of Fourier transforms
requires the PSF and the image to be of the same size the image must be padded to double
its size. In practice however, objects are usually generously contained in the image. In that
case the automatic padding mode will be sufficient.

Why is automatic deconvolution essential?

If the procedure is not automated what should you do to deconvolve an n-channel image?
You must split your parent image into n single-channel images and then generate a PSF,
estimate the background and the Signal to Noise Ratio for each of them. Next you have to
run the deconvolution algorithm channel by channel which ends you up with n restored
one-channel images. Finally you have to ‘join’ the separate images to a restored n-channel
image. Although all tools are available in the Huygens Pro it is a time consuming task. Not
to speak about multi channel Time series!
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CHAPTER 3 Establishing image
parameters

Image size

Computing time. The amount of computing time involved in deconvolving images is more
than proportional to the image size. It is therefore sensible to limit the data size as much as pos-
sible. With WF images we recommend to not record planes below and above the object which
only contain blur. Huygens Pro does not need these planes to restore your object. Since the blur
in these planes might be affected by hard to correct bleaching they might even reduce the qual-
ity of the deconvolution result.

Brick wise processing Computer memory. Deconvolving images requires much computer memory because all com-
putations are done in 32-bit floating point format, and because several extra (hidden) images
are needed to store intermediate results. To reduce the memory requirements Huygens Pro will
split your images into bricks, deconvolve the bricks sequentially, and fitthe bricks together in a
seamless fashion. Brick wise processing is an automatic feature of Huygens Pro.
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Signal to Noise Ratio (SNR)

The SNR should be estimated from the quality of the image. In Figure 13 you findsome exam-
ples of recordings where different noise levels were added to an original (restored) image.

Blacklevel

Figure 14 shows the
histograms of three
synthetic images. At
left an image homoge-
neously filled with the
value 5. At the middle
we applied Poisson
noise as if the image
was build by a CCD
camera. At the image
on the right a value of
20 was added to simulate electronic shift. This shift is called ‘blacklevel’. A lar ge blacklevel
value will reduce the effective dynamic range of your microscope, but will do no harm to the
deconvolution since it is automatically accounted for in the background estimation stage. How-
ever, it is also possible that the blacklevel is negative. An image histogram will show a spike on
the left (Clipped at zero values).

Figure 13. Exam
ple of different
SNR values.
Same image, differ-
ent SNR ratios
Top left: original
image. Top right:
image with
SNR=30. Bottom
left image with
SNR=15, Bottom:
right: image with
SNR=5

original image

blacklevel

Figure 14. Histogram of images with various blacklevel
values.
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Sampling densities

It is very important for
the quality of a decon-
volution result that all
information generated
by the optics of the
microscope is cap-
tured in digital form. It
can be shown that if
the sampling density is
higher than a certain
value all information
about the object is cap-
tured. We’ ll call this
value the critical sam-
pling distance, corre-
sponding to the
Nyquist rate. Apart
from practical prob-
lems like bleaching,
acquisition time and
data size there is no
objection at all against
using a smaller sampling distance than the critical distance, to the contrary.

Figure 15 shows the dependency of this critical sampling distance on the NA for specificwave-
lengths. To apply the plot of Figure 15 to different wavelengths you can simply scale the verti-
cal axis with the wavelength. Example: you are working with a WF microscope with NA 1.3 at
emission wavelength 570nm. From the plot you read that the critical lateral Nyquist sampling
distance at 500nm emission is 95nm, so in your case this becomes 570/500 * 95nm = 108nm.

In the confocal case it is the excitation wavelength which determines the Nyquist sample dis-
tance. In theory the pinhole plays no role, but larger pinholes strongly attenuate finestructures
at the resolution limit. Therefore, as a rule of thumb, with a common pinhole diameter of 1
Airy disk the lateral critical sampling distance may be increased by 50% with negligible loss of
information. In cases were the pinhole is much larger, the lateral imaging properties much
resemble those of a WF system and the sampling distance can be set accordingly. We do not
recommend to increase the axial sampling distance appreciably beyond the critical distance.

Data acquisition pitfalls

Refractive index mis-
match

A mismatch between the refractive index of the lens immersion medium and specimen embed-
ding medium will cause several serious problems:
• Geometrical distortion: the fishtank effect

Objects will appear elongated in the microscope. Huygens Essential will automatically
adapt the PSF to this situation, but assumes the image geometry is not corrected.

• Spherical aberration (SA)
SA will cause the oblique rays to be focussed in a different location than the central rays.
The distance in this focal shift is dependent on the depth of the focus in the specimen. If the
mismatch is large, e.g. when going from oil immersion into a watery medium, the PSF will
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Figure 15. Critical sampling distance vs. NA
The curves above show the critical sampling distance in axial and lateral
directions for WF and confocal microscopes. The emission wavelength in
the WF case was 500nm; the excitation wavelength in the confocal case is



22 The Huygens Professional User Guide

become asymmetric at depths of already a few micron. Especially harmful for WF decon-
volution. Workaround: keep the Z-range of the data as small as possible. Solution: use a
water immersion lens.

• Total internal reflection
When the lens NA is larger than the medium refractive index total internal reflection will
occur, causing excitation light to be bounced back into the lens and limiting the effective
NA.

Clipping The light intensities from the microscopic object are converted to electrical signals that pass an
adjustable amplifier. Also an electrical DC component can be added or subtracted by the
microscope operator. The electrical signal may thus range from negative to highly positive.
These electrical signals must be converted to numbers processed by the computer. This con-
verting stage is done in the CCD camera and its electronics. Most CCD cameras have an 12-bit
converter limiting the output numbers to a range of 0 to 4095. Negative input signals are usu-
ally converted to 0 while positive input values exceeding some value are all converted to 4095
(clipping): information in the clipped samples is lost.

In practice: be suspicious if you find values at the extremes in your image, probably clipping
occurred.

Undersampling One of the rules of measurement that is often overlooked is that one takes too few XY slices
from the microscopic object. In that case the sampling distance is too large (too few samples:
undersampled) which leaves you with a 3-D stack with hardly any relation between the adja-
cent planes. It is important to know how the sampling conditions should be established in order
to recover an image from the sampled values. How you should sample your object depends on
your microscope type -WF or confocal- and on the microscope parameters used, like the
numerical aperture and wavelength of the light. How to calculate the correct sampling distance
can be calculated using the formulas as given in ”The Nyquist rate” from The Huygens Reci-
pes.

Do not undersample to
limit photodamage

Some times undersampling is done to limit photodamage to live cells. If photodamage plays a
role it’ s better to distribute the available photons over more pixels, resulting in an apparently
noisier image, than putting the photons in fewer pixels to get a low noise, but undersampled,
image. Of course there are limits, but a fair trade-off can be often found.

It is better to record 10 separate noisy slices 100 nm apart than 2 slices on 1000 nm each aver-
aged 5 times on order to reduce noise. See also ”A typical e xample” from the Huygens Reci-
pes

Bleaching Bleaching is a practically unavoidable phenomenon in fluorescence microscopy. Because the
image planes are acquired sequentially, bleaching will vary along the Z direction. Assuming it
is not strong it will not affect deconvolution results on confocal or two photon images. But in
WF deconvolution bleaching is more of a problem. Fortunately, usually the bleaching in WF
images can be corrected quite easily. Huygens will do so automatically. However, if the bleach-
ing is strong the correction might not be perfect, resulting in lower quality deconvolution
results.

Illumination instabil-
ity

Some WF systems are equipped with unstable arc lamps. Huygens will correct this instability,
but when the instability is severe it cannot do so sufficiently.

Mechanical instability Mechanical instability can take many shapes, for example:
• Vibrations sometimes seen in confocal images. They may seriously hamper deconvolution
• Z-stage moves irregular or with sudden jumps. Fatal for confocal or WF deconvolution.
• Specimen moves. If in WF data the object can clearly be seen moving when slicing along

over a few micron in Z this will cause problems for the deconvolution. Best cause of action,
apart from speeding up acquisition, is limiting the Z-range of the data as much as possible.
Confocal data of moving specimen causes less problems.
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Thermal effects Thermal effects are known to affect calibration of the Z-stage, especially if piezo actuators
without feedback control are used. In particular harmful for WF data.

Internal reflection At high NA the angle of incidence of the most oblique rays can be close to 70 degrees. When a
ray has to cross the cover-glass to medium interface at such an angle total reflectionmay occur.
To be precise, total reflection occurs when the NA of your lens is higher than the refractive
index of the embedding medium. This will reduce the effective NA of the lens.

Computing the backprojected pinhole radius

Throughout the Huygens Pro and Huygens Essential pinhole sizes of confocal systems are
specified as thebackprojected radius in nanometer (rb) ‘Backprojected’ means the
size of the pinhole as it appears in the specimen plane: the physical pinhole size (rphys) divided
by the total magnificationof the detection system. This total magnificationis the product of the
(variable) objective magnification times a fixed internal magnification:

(EQ 1)

with mobj the magnificationfactor of the objective and msystem is the fixed magnificationof sys-
tem.

Airy disk as unit for
the backprojected pin-
hole

Some confocal microscopes report the pinhole size (diameter) with the Airy disk (diameter) as
unit. The backprojected pinhole radius can then be computed with:

(EQ 2)

with NAirydisks the number of Airydisks and λex the excitation wavelength. In principle using
λex is not correct because the Airy diffraction pattern is formed by the emitted light. However,
we suspect microscope manufacturers prefer to use the excitation wavelength because it is bet-
ter defined and does not depend on settings of devices like adjustable band filters. For this rea-
son in the formula above we too use λex.

Note that this relation bypasses the need to know internal system and lens magnifications.

Converting from inte-
ger parameter

Unfortunately, quite a few commercial microscopes do not report the physical pinhole size or
the Airy disk size. Instead, often an integer size parameter is specified with a range 0...255 (8-
bit). Matters are further complicated by the use of non-circular pinholes. To compensate this
we introduce a shape factor cshape which takes care of the conversion from size (diameter or
edge size) to radius. The following formula can be used to translate the 8-bit machine number
into the backprojected pinhole radius:

(EQ 3)

where p8 is the 8-bit machine number for the pinhole, smax is the maximal pinhole size in
micron, smin is the minimal pinhole size in micron. The factor 1000 is to convert from microns
to nanometer.

The shape correction from a square to a circular pinhole is based on setting the area of the
square pinhole equal to the area of the replacing circular pinhole.

rb
r phys

mobj msystem⋅
--------------------------------=

rb

0.61λexN Airydisks

NA
-----------------------------------------=

rb
P8 255⁄( ) smax smin–( )⋅ smin+

mobj msystem⋅
-------------------------------------------------------------------------- cshape 1000⋅ ⋅=
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(EQ 4)

For a square pinhole  = 0.564. For circular pinholes cshape = 0.5 to just con-
vert from diameter to radius.

Airy disk as unit for
the backprojected
radius of a square pin-
hole

The relation between the edge size of square pinhole in Airy disk units and the backprojected
radius is a combination of (EQ 2) and (EQ 4). Taking into account that (EQ 2) already converts
a diameter into a radius we get:

(EQ 5)

with NAirydisks the number of Airydisks.

Computing the backprojected pinhole distance in Nipkow spinning disks

As is the case for the backprojected pinhole diameter, the distances between the pinholes in
spinning disks must be divided by the system magnification. For the most used Yokogawa, for
example, the pinhole distance is 2.5 µ. You can check this by stopping the disk. So with an
100x lens the backprojected distance is about 2.5 µ.

Pinhole radius tables

In the case of the Leica TCS4d, the Biorad MRC500/600, the Zeiss LSM310 and the Zeiss
LSM410 type microscopes the pinhole geometry and system magnificationis known resulting
in the conversion formulas from the following tables:

Leica confocal micro-
scopes

TCS 4D, SP1, NT

The size of the square pinhole is given as an 8-bit number which maps to the physical pinhole
radius given in the following table:

TABLE 1. Leica TCS4d pinhole parameters

If the pinhole is specifiedin Airy disk units, see “Airydisk as unit for the backprojected radius
of a square pinhole” for information on ho w to convert to a backprojected radius.

d 2r
d2 πr2 and thus r d

π
-------==

cshape 1 π⁄=

rb

0.69λexN Airydisks

NA
-----------------------------------------=

TCS4d Range begin Range end

Reported parameter (p8) 0 255

Size (micron) 20 630 (earlier
reported as 500)

Pinhole geometry square

System magnification 4.5

Backprojected pinhole
radius (nm)  (EQ 6)

295 p8 2508+
mobj

---------------------------------
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TCS-SP2

The Leica TCS-SP2 has a system magnificationof 3.6. However, the size of its square pinhole
is usually specified in Airy disk units making it independent of the actual overall magnifica-
tion. It is dependent though on wavelength and NA of the objective. See “Airy disk as unit for
the backprojected radius of a square pinhole” for information on ho w to convert to a back-
projected radius.

Zeiss confocal micro-
scopes

TABLE 2. Zeiss LSM310 (upright) pinhole parameters

TABLE 3. Zeiss LSM410 (inverted) pinhole parameters

TABLE 4. Zeiss LSM510 pinhole parameters

Olympus confocal
microscopes

TABLE 5. Olympus Fluoview

Zeiss LSM310 upright Range begin Range end

Reported parameter (p8) 0 255

Size (micron) 0 500

Pinhole geometry square

System magnification 1.11

Backprojected pinhole
radius (nm)  (EQ 7)

Zeiss LSM410 inverted Range begin Range end

Reported parameter (p8) 0 255

Size (micron) 0 1000

Pinhole geometry square

System magnification 2.23

Backprojected pinhole
radius (nm)  (EQ 8)

Zeiss LSM510

Size (p,diameter,micron)

Backprojected pinhole
radius (nm)  (EQ 9)

996 p8⋅
mobj

-------------------

992 p8⋅
mobj

-------------------

p 1000⋅
6.66 m⋅ obj
-------------------------

Olympus Fluoview

Reported parameter 1 2 3 4 5

Size (p, diameter, micron) 0 100 150 200 300

Pinhole geometry circular?

System magnification 3.426

Backprojected pinhole
radius (nm)  (EQ 10)

p
6.85mobj
---------------------
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Biorad confocal micro-
scopes

TABLE 6. Biorad MRC600, 1024, Radiance

Checking the Biorad system magnification

The Biorad MRC500/600/1024 microscopes have a very high magnification in the detection
system. The fixed system magnificationis according to Pawley [Pawley 1995, p 30] 53 × mtube,
mtube between 1.0 and 1.56 (a factor 1.25 for the ‘fluorescence attachment and also a factor
1.25 for the ‘DIC’ attachment). The factor of 53 includes the 8× “eyepiece” just below the scan
head, but doesn’ t include that variability in magnification due to the variations in tube-length
that are result from the aligning the system.

The high system magnificationallows you to view the diffraction pattern (Airy disk) at the pin-
hole plane directly by eye. To enable you to verify the correctness of (EQ 11) in the table above
for your instrument we outline the way the system magnification was derived:

In a Biorad MRC600 with a 1.3 60x objective the Airy disk has a diameter of around 2-2.5mm
at the pinhole plane. The diameter of the first Airy zero ring is 7.6 lateral optical units (o.u.),
with a lateral optical unit v defined as:

(EQ 12)

with n sinα the numerical aperture. In the system above an o.u. is 0.3 �± 0.033 mm. At the spec-
imen plane (backprojected) a lateral o.u. is in this case around 61nm. The total magnification
appears thus to be 4918, the system magnification82 �± 9. This value corresponds well with the
largest possible system magnification for the MRC600.

A supplied calibration
curve

If a calibration curve was supplied with your microscope best use that curve to convert the dis-
played setting to a physical size and from there convert to the backprojected radius.

Questions

What does the quality
factor mean while run-
ning Huygens?

Deconvolution as it is done in Huygens Pro hinges around the idea of finding an as good as
possible estimate of the object that is imaged by the microscope. To assess the quality of an
estimate, Huygens Pro computes the image of each estimate as it would appear in the micro-
scope and compares it with the measured image. From the difference a quality factor is com-
puted. The difference is also used to compute a correction factor to modify the estimate in such
a way that the corrected estimate will yield a better quality factor. The quality factor as

Biorad MRC600/ 1024/
Radiance

Reported parameter (p8) n.a.

Size (diameter in mm) 0-8

Pinhole geometry circular

System magnification
[Pawley 1995, p 30]

53-83, reported 60 for the
Radiance, 53 for the 1024

Backprojected pinhole
radius (nm) as function of
the physical diameter d
(mm)

 (EQ 11)
d 106⋅

2 msystem m⋅ ⋅ obj
---------------------------------------

v x 2π
λ

------n αsin=
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reported by Huygens Pro is a measure relative to the first estimate and therefore a number
greater or equal to 1. If the increase in quality drops below a threshold the iterations are
stopped.

Can I deconvolve a
Tiff series?

Yes, if the series is a numbered series like: slice001.tif, slice002.tif.....slice0NN.tif, Huygens
Pro will read the series into a single 3D image. Because Tiffs usually carry no additional
microscopic information, check the parameters carefully.

Tiff file series naming
convention

If you have Tiff images to be read into the Huygens Pro or the Huygens Essential you should
know about the naming convention used.

If you select a filefrom a numbered series, the selected fileand the following fileswill be inter-
preted as x-y planes of a 3D stack and read into a 3D image of suitable size and channel config-
uration.

A one-channel 3D images only go with numbers:
As an example a dataset called ‘c’ with 32 slices numbers as follo ws:
c000.tif
c001.tif
.......
.......
c031.tif

If you wish to work on the complete c stack you only have to select ‘c000.tif’ while opening. If
you select file ‘c020-tif’ the first 20 slices will be skipped.

Numbered series without the Tiff extension like
c04
c05
...
c18

are not read in as a series.

Huygens Essential and Professional read and write Tiff series with Leica style numbering if
there are more channels (different wavelenghts), slices or frames(in time).

An image of four slices and two frames is named with Leica style numbering as follows:
c_t00_z000.tif
c_t00_z001.tif
c_t00_z002.tif
c_t00_z003.tif
c_t01_z000.tif
c_t01_z001.tif
c_t01_z002.tif
c_t01_z003.tif

And an image ‘sTCh’ of four slices, three frames and tw o channels:
sTCh_t00_z000_ch00.tif
sTCh_t00_z000_ch01.tif
sTCh_t00_z001_ch00.tif
sTCh_t00_z001_ch01.tif
sTCh_t00_z002_ch00.tif
sTCh_t00_z002_ch01.tif
sTCh_t00_z003_ch00.tif
sTCh_t00_z003_ch01.tif
sTCh_t01_z000_ch00.tif
sTCh_t01_z000_ch01.tif
sTCh_t01_z001_ch00.tif
sTCh_t01_z001_ch01.tif
sTCh_t01_z002_ch00.tif
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sTCh_t01_z002_ch01.tif
sTCh_t01_z003_ch00.tif
sTCh_t01_z003_ch01.tif
sTCh_t02_z000_ch00.tif
sTCh_t02_z000_ch01.tif
sTCh_t02_z001_ch00.tif
sTCh_t02_z001_ch01.tif
sTCh_t02_z002_ch00.tif
sTCh_t02_z002_ch01.tif
sTCh_t02_z003_ch00.tif
sTCh_t02_z003_ch01.tif

Can I deconvolve a sin-
gle plane widefield
image?

Yes, single plane WF deconvolution works because the data are extrapolated into a region
above and below the plane spanning typically between 10-20 planes of 100-300 nm sampling
in Z. The software generates an appropriate PSF.

Can I deconvolve a sin-
gle Tiff image?

Yes. Huygens Pro treats the image as the only known plane of a 3D stack and proceeds as
usual. Set the z-sampling distance to the Nyquist value, see “Data acquisition pitfalls” on
page 21.
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Numerics
2D images 28

A
addresses

IBM 6
Scientific Volume Imaging B.V. 6
Silicon Graphics Inc. 6

Airy disk 23, 25, 26

B
backprojected pinhole distance 24
backprojected pinhole size 23
Biorad

MRC500/600/1024 26
MRC500/600/1024/Radiance 26

blacklevel 20
bleaching 22
bleaching correction 16
brick 19

C
clipping 10, 22
computer memory 19
computing the backprojected pinhole

diameter 23
computing the backprojected pinhole

distance 24
computing time 19
conversion into backprojected pinhole

size 23
critical sampling distance 21

D
deconvolution functions 3
deconvolving

a single plane wide field image 28
Tiff images 27

distributors 6

E
email SVI 6

F
FAQ web support 6
faxing SVI 6
Frequently Asked Questions see FAQ

G
geometrical distortion 21

H
histogram 20

I
IBM 6
illumination instability 22
internal reflection 22, 23
Irix 5

K
knowledge Base 7

L
Leica 24, 25

TCS-4D 24
TCS-NT 24

TCS-SP1 24
TCS-SP2 25

Leica style numbering 27

M
mechanical instability 22

N
non-circular pinhole 23, 24
numbering of Tiff series 27
Nyquist rate 21

O
Olympus Fluoview 25
optical

unit 26

P
padding 16
padding and Wide Field images 17
pinhole

backprojected 23
backprojected pinhole distance 24
non-circular 23, 24

R
refractive index mismatch 21
rpm 4

S
saturation 10
Scientific Volume Imaging B.V. 6
shape factor 23
Silicon Graphics Inc. 6
single plane wide field deconvolution 28
SNR 20
specimen moves 22
spherical aberration 21
square pinhole 23, 24
stopping criterion 16

T
thermal effects 23
TIFF

series 27
Tiff image deconvolution 27
Tiff series numbering 27
Tiff slices 8
total internal reflection 22

U
undersampling 22
unstable arc lamps 22

V
vibrations 22

W
WF 3
widefield 3

Z
z-drift 3
Zeiss 25

LSM310 25
LSM410 25
LSM510 25

z-stage moving 22




